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Что такое GMSH?

GMSH  –  бесплатный  (GNU  GENERAL PUBLIC  LICENSE,  Version  2)  Пре-  Постпроцессор  для 
построения  параметризованных  твердотельных  моделей,  получения  сеток,  а  также  для  визуализации 
результатов расчета. Собственно GMSH никаких расчетов не выполняет,  и может быть использован в 
комплекте с  другими программами (решателями или солверами), такими как Code-Aster, CCX/CalculiX, 
Impact, getdp и т.д. 

Ссылка на сайт программы:
http://www.geuz.org/gmsh/

Не обойдем вниманием автора программы. 

Prof. Christophe Geuzaine, University of Liège

Установка GMSH 

Здесь и далее речь пойдет о версии для ОС Windows. 
Закачиваем  с сайта автора архив (у меня в данный момент gmsh-2.0.7-Windows.zip).
Распаковываем его в отдельную папку (у меня C:\gmsh-2.0.7-Windows) и  запускаем файл  gmsh.exe 

(рис. 1). 
То что возникло на экране далее мы будем называть «Графическое Окно» и «Окно Меню».
Сразу обратим внимание на заголовок Графического Окна. Он буквально указывает нам на то, что 

создан  и  открыт  файл  untitled.geo  на  C:\Documents  and  Settings\root\Local  Settings\Temp  (это  у  меня 
конкретно такой путь). Это – файл модели, которую вы будете строить. Ваши  действия в виде команд 
будут записываться в этот файл. То, что вы наваяеете, будет сохранено в этом файле и после закрытия 
программы. Если что то пойдет не так, программа вылетит, и, при следующем запуске при открытии 
данного  файла  (с  сохраненными  ошибочными  действиями)  вылетит  повторно.  Для  того  чтобы 
продолжать работу, вы должны будете зайти в папку по указанному пути (какой у вас), отредактировать 
файл untitled.geo (или очистить его), затем сохранив. Тогда при следующем открытии все будет ОК.

Если вы хотите посмотреть и подправить содержимое файла в процессе работы, то выбираете Edit в 
окне Меню (рис. 1). Geo файл с записанными в нем командами откроется в текстовом редакторе. После 
правки и сохранения, вам нужно выполнить Reload, т.е. перегрузить модель.
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Рис. 1 – Окна GMSH

Начнем с простого примера

Один из примеров приведен на сайте автора: http://geuz.org/gmsh/doc/gui_tutorial/elementary.html
Мы же построим прямоугольник размерами 5 на 3 единицы. В Окне Меню выбираем:
Geometry => Elementary Entities => Add => New => Point
Возникнет окно “Contextual Geometry Definitions” с активной закладкой “Point” (рис. 2).
Вводим в “текстбоксы” X=0, Y=0, Z=0 – значения координат первой точки и жмем Add.
Также, имеется возможность вводить точки указателем мыши непосредственно в Графическом Окне 

(для этого перемещаем указатель и жмем “e” на клавиатуре).
Последовательно вводим значения координат трех оставшихся точек и каждый раз жмем Add:
X=5; Y=0;
X=5; Y=3;
X=0; Y=3.
 В процессе ввода точек они отображаются в Графическом Окне.
Обратим внимание на “текстбокс” с названием “Characteristic length” (“Характеристическая длина”), 

в  котором  уже  стоит  по  умолчанию  значение  0.1.  Эта  величина  связана  с  размером  КЭ  сетки 
примыкающей к вводимой точки, и мы вернемся к ней позднее.

Закрываем окно “Contextual Geometry Definitions”.
Отобразим номера введенных точек. 
Tools => Options  => Geometry 
на закладке Visibility ставим галочку “Роint Numbers”
Результат показан на рис. 3.
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Рис. 2 – Ввод координат точек

Рис 3 – Отображение номеров точек



Вводим линии (отрезки линий). Для этого в Окне Меню выбираем:
Geometry => Elementary Entities => Add => New => Straight Line
И осуществляем ввод, последовательно кликая указателем мыши по точкам в Графическом окне 

(рис. 4). 
Осталось построить прямоугольник (плоскую фигуру) ограниченный введенными линиями.
 Выбираем:
Geometry => Elementary Entities => Add => New => Plane Surface
В заголовке Графического окна появляется надпись Select Boundary (Выбери границу). Кликаем по 

любой  линии,  ограничивающей замкнутый контур  и  наблюдаем  “покраснение”  оного.    В  заголовке 
Графического окна появляется надпись Select hole boundaries (Выбери границы отверстия или полости 
внутри прямоугольника). Так как никаких отверстий у нас изначально не планировалось жмем “е” на 
клавиатуре для окончания выделения. 

В Графическом Окне внутри прямоугольной области обозначились пунктирные линии, образующие 
крест. Это – текущее обозначение поверхности в программе GMSH.

Рис. 4 – Ввод наружного контура прямоугольника

Твердотельная модель прямоугольника, в целом, построена.
Возвращаемся  в   Geometry  =>  Edit  (рис.  1).  Отрывается  программа  “Блокнот”  и  перед  нами 

предстают команды, записанные в процессе выполнения действий в интерактивном режиме. Вот список 
этих команд.

Point(1) = {0,0,0,0.1};
Point(2) = {5,0,0,0.1};
Point(3) = {5,3,0,0.1};
Point(4) = {0,3,0,0.1};
Line(1) = {1,2};
Line(2) = {2,3};
Line(3) = {3,4};
Line(4) = {4,1};



Line Loop(5) = {3,4,1,2};
Plane Surface(6) = {5};

Не нужно обладать  незаурядным интеллектом,  чтобы понять  что  Point(1)  =  {0,0,0,0.1}  означает 
точку №1 с  нулевыми  координатами  (а  четвертое  значение,  равное  0,1  как  раз  тот  самый  параметр 
“Characteristic length”, о котором говорилось выше).

Исправим и закомментируем команды  следующим образом:

//Модель прямоугольника в программе GMSH
//Исходные данные:
//Размеры
b=5;
h=3;
// Характеристическая длина в окрестности точек
cl1=b/10;
cl2=Sqrt(b^2+h^2)/100;
//Ввод точек
Point(1) = {0,0,0,cl1};
Point(2) = {b,0,0,cl1};
Point(3) = {b,h,0,cl2};
Point(4) = {0,h,0,cl1};
//Ввод линий
Line(1) = {1,2};
Line(2) = {2,3};
Line(3) = {3,4};
Line(4) = {4,1};
//Обозначение контура
Line Loop(5) = {3,4,1,2};
//Поверхность прямоугольника
Plane Surface(6) = {5};

Как мы видим, через “//” вводятся комментарии (после этих символов программа не воспринимает 
введенный текст, как команды). Стороны прямоугольника параметризированны и обозначены как “b” и 
“h” (не  забываем ставить точку с  запятой после значений параметров).  Значения характеристических 
длин приняты в долях от  размеров прямоугольника:  параметр “cl1”  для  точек №1,  2,  4  взят  1/10 от 
ширины  прямоугольника,  а  параметр  “cl2”  в  окрестности  точки  №3  -  одной  сотой  от  диагонали 
Sqrt(b^2+h^2) (корень квадратный из суммы квадратов сторон, по теореме Пифагора). 

Сохраняем исправленный файл  untitled.geo (Блокнот пока не закрываем – вдруг ошиблись и GMSH 
вылетит. Как я уже писал выше, ничего страшного в этом нет, но ошибки придется исправлять.).

Выполняем  Geometry => Reload  (см. рис. 1) и видим перед собой прежний прямоугольник, ничуть 
пока не изменившийся (мы ведь не меняли численные значения параметров  в текстовом файле!).

Выбираем в “Комбобоксе” Окна Меню “Mesh” (“мэш” – т.е. сетка) и давим на кнопку “2D”.
Результат показан на рис. 5. Получилось то, что в нашем отечестве и в ближнем зарубежье называют 
“триангуляция”,  причем  обращает  на  себя  местное  сгущение  сетки  в  районе  точки  №3 по  причине 
принятия  для  нее  соответствующего  значения  характеристической  длины.  Итак,  у  нас  получились 
трехузловые  элементы  первого  порядка.  А  если  мы  надавим  на  кнопку  “Second  Order”  на  экране 
Графического Окна будут уже шести-узловые элементы (треугольные, с промежуточными узлами), как 
известно – на порядок более точные с расчетной точки зрения, а следовательно не требующие большого 
измельчения  для  получения  заданной точности.   На  практике сетка  сгущается  в  зонах  концентрации 
напряжений, там где напряжения меняются резко на небольшом отрезке. Там, где градиент напряжений 
не высок, можно обойтись более грубой сеткой, а мельчить все одинаково – непроизводительно с точки 
зрения точности и экономии машинных ресурсов. 

Если мы зайдем на вкладку: Mesh => Define => Recombine , выделим поверхность, по окончании 
выделения нажмем “е” и разобьем заново, то получим результат, показанный на рис. 6, а в список команд 
добавится строчка:

Recombine Surface {6};
Итак, мы воспользовались для разбивки на КЭ кнопкой “2D”. “2D” - не обязательно означает плоскую 
сетку, ей нужно пользоваться и для разбивки криволинейных, пространственных поверхностей, таких, 
как в примере из  http://dwg.ru/dnl/3563 и поверхностей, ограничивающих объемные тела.
  Для разбивки объемных тел на объемные элементы нужно пользоваться кнопкой “3D”.
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Рис. 5 – Разбивка прямоугольника на КЭ

Рис. 6 – Рекомбинированная сетка



Построим 3D- тело вытягиванием нашего прямоугольника.
Geometry => Elementary Entities => Extrude => Rotate => Surface.
Возникнет окно “Contextual Geometry Definitions” с активной вкладкой “Translation”.
Вводим в него значения, как показано на рис. 7, выделяем указателем мыши нашу единственную 

поверхность и нажимаем клавишу “е” на клавиатуре. В результате в geo-файл добавится выражение:

Extrude {{1,0,0}, {b/2,10*h,0}, Pi/2} {
  Surface{6};

}
А созданное вращением объемное тело будет иметь вид как на рис. 7 внизу.

Рис. 7 – Получение объемного тела вращением.
Для разбивки на конечные элементы установим новые значения параметра сетки, т.е. переназначим 

характеристическую длину (при слишком большом числе элементов программа может вылететь из-за 
нехватки памяти в Windows).

Заходим на  Mesh => Define => Characteristic length ,  вводим значение b/6 вместо 0,1, выделяем 
точки в Графическом окне и по окончании выделения (все точки покраснеют) давим “е”, как предлагает 
нам подсказка в заголовке Графического окна (для выделения точек не по одиночке, а с помощью лассо 
пользуемся мышью с  нажатой и  удерживаемой клавишей “Ctrl”).  В результате в  geo-файл добавится 



выражение:
Characteristic Length {26,28,3,2,4,1,5,14,6,10} = b/6;

Заходим на вкладку  Mesh, и нажимаем кнопку 3D. Разбитое на КЭ тело показано на рис. 8.

Рис. 8 – Объемное тело, разбитое на конечные элементы.

При вытяжке поверхности – получается объемное тело,  при вытяжке линии – поверхность,  при 
вытяжке точки – линия. 

В  данной  главе  мы  рассмотрели  элементарные  примеры  построения  модели  в  GMSH,  обойдя 
стороной многие важные вопросы  (создание групп, построение сплайнов, графические настройки и т.д.). 
Наконец,  мы  совсем  не  коснулись  возможности  GMSH,  как  постпроцессора  (просмотр  и  анализ 
результатов расчетов). 

Предполагается,  что  читатель,  заинтересовавшись  программой  освоит  это  все  сам  на  досуге, 
используя документацию, англо-русский словарь и “метод тыка”.

Форматы файлов

До сих пор мы ничего не открывали и не сохраняли. Как уже было замечено выше, GMSH ничего 
сам  не  считает,  поэтому  естественно  он  должен  быть  связан  с  другими  программами  посредством 
создаваемых и прочитываемых им  файлов.

Сделать это можно как обычно, через выпадающее меню “File” Окна Меню, выбрав “Open” или 
“Save As”. (рис. 9). Рассмотрим некоторые форматы файлов по их расширениям. 

- Gmsh geometry  .geo – файл геометрии GMSH;
- STEP и IGES – известные форматы файлов геометрии, поддерживаемые многими CAD-

пакетами. Импорт  STEP и IGES, разработанный для GMSH на основе открытой библиотеки OpenCascade 
позволяет  загружать в программу модели, построенные в сторонних CAD-ах (обратная выгрузка модели 
из .geo в данные форматы пока не предусмотрена), в т.ч. в открытом пакете Salome.

- STL surface mesh – распространенный формат для передачи поверхностей через треугольные 
сетки.

- .msh файл – файл сетки GMSH.
и  другие.
Сохраним модель из нашего примера в файл simple-test.geo. и откроем его текстовым редактором. 

Заметим, что содержимое файла отличается от текущего содержимого  файла untitled.geo. Программа как 
бы сделала слепок с текущей модели, при этом утеряв значения параметров и упростив код. Поэтому 
вторым, более удобным способом сохранения модели является копирование содержимого  untitled.geo в 
другой текстовый файл (с присвоением другого имени и расширения .geo).
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Попробуем  сохранить  сетку  в  msh-файл.  При  сохранении  нам  будет  предложено  выбрать  три 
варианта  формата:  Version1.0,  Version2.0  ASCII  и  бинарную версию 2.0.  Более  подробно  о  форматах 
файлов написано на сайте автора программы. Выберем любой требуемый тип и произведем сохранение. 

Рис. 9 – Форматы файлов по расширениям

Другие открытые и бесплатные мешеры и пре- постпроцессоры

Рассмотренный нами Пре- Постпроцессор GMSH не лишен недостатков и даже багов. Во первых он 
имеет не особенно богатые собственные средства построения CAD-модели. Во вторых, он “вылетает” 
если  что  то  идет  не  так  (в  Linux  работа  более  стабильна).  Со  слов  самого  автора,  программа  не 
предназначена быть универсальным инструментом для промышленных задач и предназначена в большей 
степени для  целей учебных и академических.  Хотя,  при известной сноровке в  GMSH все  же можно 
строить достаточно сложные и интересные модели (см. например geo-файлы в папке GMSH/ demo).

В  оправдание  заметим,  что  GMSH  написан  одним  человеком  для  совершенно  различных 
операционных систем (Linux, Windows и MacOS) с использованием открытых (а, следовательно не очень 
богатых)  средств  программирования.  Программа  не  продается  за  деньги  и  не  распространяется  под 
громкими  названиями.  Тем  не  менее  ее  качества  говорят  сами  за  себя  и  обуславливают  ее 
распространенность и популярность среди пользователей в разных странах.

Более “тяжелым” пре- постпроцессором, наверно самым “тяжелым” в своем роде, среди открытых 
программ является система Salome. Это промышленная система, развиваемая с 2000-го года, о которой 
более подробно вы можете прочитать по ссылкам:

http://www.salome-platform.org/home/presentation/overview/
http://www.salome-platform.org/home/utilization/alliances/
http://www.salome-platform.org/home/screenshots/
К сожалению (или к счастью) данная программа функционирует только в  среде  Linux.  Хотя,  по 

большому счету, это не является препятствием к ее использованию, т.к. весь вопрос состоит только в 
выделении  нескольких  гигобайт  на  винчестере  и  закачке  DVD  PCLinuxOS  с  предустановленной 
программой  Salome  (и  почти  всеми  программами,  о  которых  идет  речь  в  этой  статье).  Смотрите 

http://www.salome-platform.org/home/screenshots/
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подробнее по ссылке:
http://www.caelinux.com/
С другой известной бесплатной программой-мешером – NETGEN, вы можете ознакомиться на сайте:
http://www.hpfem.jku.at/netgen/
(и там же закачать версию и код для ОС Windows и Linux).
NETGEN поддерживает импорт  STEP и IGES и позволяет сохранять сетку во многие специальные 

“сеточные” форматы (рис. 10).

Рис. 10 – Разбивка на КЭ в программе NETGEN для OS Windows

Пре-  постпроцессор  GiD  не  является  бесплатной  программой,  хотя  его  демо-версия  позволяет 
строить небольшие модели  и  может быть  использована для  некоммерческих целей.  Читайте  об  этой 
программе на сайте:

http://gid.cimne.upc.es/
Наконец, упомянем о пре- постпроцессоре CGX в составе пакета CalculiX, о котором подробней – в 

следующем разделе.

Внешние “решатели” GMSH

Солвером номер один для GMSH является промышленный пакет Code-Aster. Эта программа, как и 
Salome  заслуживает  пристального  внимания,  поэтому  пока  не  будем  останавливаться  на  ней,  а 
ограничимся основными ссылками, по которым вы можете получить необходимую информацию:

http://dwg.ru/dnl/3548
http://www.code-aster.org

http://www.code-aster.org/
http://dwg.ru/dnl/3548
http://gid.cimne.upc.es/
http://www.hpfem.jku.at/netgen/
http://www.caelinux.com/


http://www.necs.fr/
http://www.caelinux.com

Другой известной программой, которую можно использовать вместе с GMSH является CalculiX.
Calculix – открытый, бесплатно распространяемый конечно-элементный пакет для моделирования 

нелинейностей, решения задач статики, динамики, теплопроводности и т.д. 
Дистрибутив для Win32 можно скачать на сайте: 
http://bConverged.com/
 
Официальный сайт программы: 
http://www.calculix.de/

Достаточно представительный форум с участием разработчиков пакета на:
http://groups.yahoo.com/group/calculix/

Справка к программе на английском языке:
http://dwg.ru/dnl/2224

Русский перевод “Начинаем работать с CalculiX” (с дополнениями) от автора настоящей статьи на:
http://www.dwg.ru/dnl/2517

Наконец, бесплатный конвертер сетки GMSH=>CalculiX с краткой инструкцией на русском языке 
на:

http://dwg.ru/dnl/3562

Обратим ваше внимание на программу Impact, которая поддерживает импорт сетки из GMSH через 
форматы .msh и поверхностной сетки - через .stl. Это пакет, написанный на Java уже потому заслуживает 
внимание,  что  в  команде  его  разработчиков  присутствуют  наши  (бывшие?)  соотечественники,  и,  в 
частности  он  содержит  справку  на  двух языках  –  английском  и  русском.  Просто  приведу  фрагмент 
Введения:

“Программный  комплекс  Impact  относится  к  классу  программ  для  выполнения  нелинейного  
динамического анализа который всегда можно свести к статике (частный случай динамики). Также  
удобство работы состоит в том, что любую конечно-элементную модель в Impact можно решить в  
динамической  постановке,  задав  только  закон  изменения  действующих  нагрузок,  граничных  условий.  
Комплекс  позволяет  находить  решение  для  моделей  из  упругих  и  неупругих  тел  с  линейными  и 
нелинейными характеристиками. Задание свойств упругих и неупругих тел производится очень просто и 
легко. Процесс моделирования тоже довольно простой и состоит из описания геометрической формы с  
указаниями свойств тела и задания закона изменения действующих нагрузок, граничных условий. После  
решения пользователь получает изменения во времени ускорения, скорости, перемещений, деформаций 
напряжений в любой точке созданной модели. Это позволяет инженеру проводить анализ элементов и  
механизмов довольно быстро и точно. Также полученные данные могут использоваться и для других  
расчетов как например расчет усталостной прочности и оценки долговечности конструкции в целом и  
отдельных ее узлов и т.д.”. От себя добавлю, что хоть и не все так легко (нужно приспосабливаться), но, 
в целом , программа заслуживает внимания и может быть использована для своих задач.

Сайт программы: http://impact.sourceforge.net/
Предварительно следует загрузить виртуальную машину Java:
http://java.sun.com/j2se/1.4.2/download.html
Инсталлируем Java, закачиваем архив Impact, 
http://sourceforge.net/project/showfiles.php?group_id=47487
распаковываем его, и запускаем файл ImpactGUI.bat 
А далее – читайте справку на английском или на русском, загружайте и просчитывайте примеры, 

которые идут вместе с программой. Вот простой пример расчета пластинки.
Программа довольно медленная (в связи с Java?), однако поддерживает вычисления на кластерах. В 

последнее время развивается, но представительного форума с поддержкой (как у CalculiX) я не нашел.

http://impactprogram.wikispaces.com/Tutorial1
http://impactprogram.wikispaces.com/Tutorial1
http://impactprogram.wikispaces.com/Tutorial1
http://sourceforge.net/project/showfiles.php?group_id=47487
http://java.sun.com/j2se/1.4.2/download.html
http://impact.sourceforge.net/
http://impact.sourceforge.net/
http://impact.sourceforge.net/
http://dwg.ru/dnl/3562
http://www.dwg.ru/dnl/2517
http://dwg.ru/dnl/2224
http://groups.yahoo.com/group/calculix/
http://www.calculix.de/
http://bConverged.com/
http://www.caelinux.com/
http://www.necs.fr/


Экспорт сетки GMSH в вычислительный комплекс SCAD Structure 

Не мог обойти этот вопрос, в связи с распространенностью SCAD, хотя сам активным пользователем 
этой  программы я  не  являюсь.  Какие  либо  специальные  конвертеры,  разработанные  специально  для 
передачи сетки из GMSH в SCAD мне не известны. На форуме

  http://dwg.ru/f/showthread.php?t=17460&page=2     
описан алгоритм передачи поверхностной треугольной сетки через формат .stl. Вернее, поскольку в 

текущей версии ПВК SCAD импорт .stl хоть и значится, но не работает, то фактически сетка передается 
через формат .DXF посредством использования открытого 3D – моделера blender3D (рис. 11) 

http://www.blender.org/
Надо полагать этот же способ пригоден и для передачи сетки GMSH не только в SCAD но и в другие 

вычислительные комплексы, поддерживающие формат DXF.

Рис. 11 – Передача stl сетки из GMSH в SCAD через DXF/blender3D

http://www.blender.org/
http://dwg.ru/f/showthread.php?t=17460&page=2
http://dwg.ru/f/showthread.php?t=17460&page=2
http://dwg.ru/f/showthread.php?t=17460&page=2

